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During cementing operations, the time required for a cement slurry to set is 
of primary concern. Under an ideal situation, minimal time would be required 
to successfully pump the slurry, which immediately upon placement, begins 
to develop compressive strength. However, if insufficient time is allowed to 
fully pump the cement, it will be necessary to drill the cement remaining in the 
casing string. Remedial operations such as this are very costly. Conversely, 
cements that are successfully placed, but require considerable time to 
cure, consume valuable rig time, which is also quite costly. Laboratory tests 
should be conducted under simulated reservoir conditions to examine the 
actual thickening time of the slurry. The OFITE Benchtop Consistometer 
was specifically engineered to determine the thickening time of well cements 
under simulated downhole pressures and temperatures.

A cement is mixed and poured into the slurry cup assembly. The slurry 
cup is placed into the test vessel and pressure is increased via an air-
driven hydraulic pump. A touch-screen display controls an internal heater, 
which maintains the necessary temperature profile, while a magnetic drive 
mechanism rotates the slurry cup assembly at 150 RPM. A potentiometer 
controls an output voltage, which is directly proportional to the amount of 
torque the cement exerts upon an API-approved paddle. The touch-screen 
display graphs cement consistency and temperature as a function of time. 

 - Maximum Pressure: 16,000 PSI (110.3 MPa)
 - Maximum Temperature: 400°F (204.4°C)
 - Touch screen display controls temperature and displays and graphs 

temperature, pressure, and consistency
 - Can operate with a computer or in standalone mode
 - Conditions well cement under temperature and pressure for further API 

testing
 - Pressure generated via an air-driven hydraulic pump
 - Drive table is rotated with a magnetic drive
 - External cooling jacket aids cooling of the test cell
 - Electronic timer with alarm, elapsed 0.1 minute resolution
 - Deadweight calibration unit included
 - Temperature and consistency alarms provide automatic shutdown
 - Safety head with rupture disk are provided
 - Unit is fully capable of testing cements in strict accordance to the 

guidelines as stated in API Specification 10
 - Pressure displayed in PSI/MPa; Temperature displayed in °F/°C
 - Compact size and light weight make the unit suitable for the benchtop

 - Air/Nitrogen Supply (100 - 150 PSI / 690 - 1,035 kPa)
 - Water Supply for Cooling (40 PSI / 276 kPa)
 - Water Drain
 - 220 Volt, 50/60 Hz, 25 Amp electrical power supply

Intro

Description

Features

Requirements
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Specifications Size 25 × 16 × 20 inches (63.5 × 40.6 × 50.8 cm)
Weight 215 lb (94.6 kg)
Crated Size 30 × 20 × 24 inches (76.2 × 50.8 × 61 cm)
Crated Weight 255 lb (115.8 kg)
Temperature Controller Touch Screen Display
Internal Heater 2,500 Watt

Slurry Cup 150 RPM Rotational Speed; 316 Stainless Steel; 
Expansion Chamber

Maximum Temperature 400°F (204.4°C)
Maximum Pressure 16,000 PSI (110.3 MPa)

#120-001 Mineral Oil, 1 Gallon, Qty: 3
#120-104 Rupture Disk, 17,500 PSI
#120-208-1 Slurry Cup Thermocouple
#120-519 Slurry Cup Assembly, No Expansion Cap
#120-502 Molded Diaphragm
#120-503 Paddle Pin
#120-506 Paddle
#120-90-033 Air Filter
#120-90-035 Filter
#130-79-15 Serial Cable
#130-79-14-1 USB Cable
#152-38 Power Cable
#120-628 Potentiometer Assembly:

#120-602 Calibration Spring
#120-603 Potentiometer Body
#120-604 Potentiometer Resistor
#120-605 Contact Spring
#120-606 Potentiometer Contact Arm
#120-607 Contact Strip
#120-608 Grounding Cable Retaining Screw
#120-609 Grounding Contact Spring
#120-75-10 Slotted Weight Set
#120-75-9 Weight Hanger

#120-90-00 Cell Assembly:
120-90-049 Cell Cap Backup Ring
120-146 Mag Drive O-ring
120-147 Mag Drive
120-148 Retaining Ring
120-149 Test Cell O-ring
120-206 2,500 Watt Heater
120-257 Drain Plug O-ring
503-258V90 O-Ring, Qty: 2

Components
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#120-91 Spare Parts for #120-90:
#120-001 Mineral Oil, 1 Gallon, Qty: 2
#120-104 Rupture Disk, 17,500 PSI, Qty: 3
#120-105 High-Pressure Check Valve
#120-146 Mag Drive O-ring, Qty: 12
#120-148 Cell Cap Backup Ring, Qty: 2
#120-149 Test Cell O-ring, Qty: 12
#120-204 Heater Gasket, Qty: 2
#120-208-1 Slurry Cup Thermocouple, Qty: 2
#120-257 Drain Plug O-ring, Qty: 12
#120-501 Slurry Cup Sleeve, Qty: 2
#120-502 Molded Diaphragm, Qty: 25
#120-503 Paddle Pin, Qty: 24
#120-504 Pivot Bearing, Qty: 10
#120-505 Pivot Bearing Gasket, Qty: 5
#120-506 Paddle, Qty: 6
#120-507 7¾" Paddle Shaft, Qty: 10
#120-508 Diaphragm Retaining Ring, Qty: 6
#120-509 Drive Disc
#120-510 Drive Bar
#120-511 Slurry Cup Shear Pin, Qty: 24
#120-512 Slurry Cup Drive Pin, Qty: 12
#120-513 Slurry Cup Gasket, Qty: 12
#120-519 Slurry Cup Assembly, No Expansion Cap
#120-602 Calibration Spring, Qty: 6
#120-604 Potentiometer Resistor, Qty: 6
#120-606 Potentiometer Contact Arm, Qty: 6
#120-607 Contact Strip, Qty: 6
#120-628 Potentiometer Assembly
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Setup 1. Carefully remove the instrument from the wooden crate and place it on a 
stable surface.

2. Connect an air or nitrogen supply (100 - 150 PSI / 690 - 1,035 kPa) to the 
Air Supply port on the back of the instrument.

This unit uses ¼" NPT female connectors for all supply lines.

3. Connect the Drain and Water Supply lines, also on the back of the unit.

4. Make sure all electrical switches are turned off and the unit is grounded. 
Make the necessary electrical connections in accordance with local 
codes.

5. Plug the Main Cable, Pressure Cable, and Thermocouple Cable into the 
appropriate ports on the unit cabinet and connect the other ends to the 
ports on the back of the Control Box.

6. If you are using a computer, connect the Control Box to the computer with 
the supplied USB cable (#130-79-16).

Main Cabinet

Pressure Power
Thermocouple Main Cable

Control Box

Main Cable Pressure Cable Thermocouple Cable
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7. To fill the oil reservoir, remove the oil reservoir cap and pour mineral oil 
into the reservoir until it is full. Replace the cap. Make sure the seal is air 
tight. Use the sight glass on the side of the reservoir to check the oil level. 
The oil level should be about ½" from the top of the sight glass.

Thermocouple Port

Calibration 
Port

Oil 
Reservoir 
Cap

Test Cell
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Software
Setup

1. Double-click the “CEM-D” icon on the PC desktop.

2. Right-click on the correct device and select “Default Device”.

3. Click “Done”.

4. The main screen shows the Elapsed Time, Temperature, Pressure, 
Consistency (in both Bc and V) and Motor RPM for the current test. It also 
has tabs for Info, Profile, Events & Cal Values, Chart, and Log Data.

5. Select “Options” from the “Edit” menu.

6. Choose an “Archive Path”. This is the folder where all test data will be 
stored.

7. Choose a “Logo File”. This is the logo that will print on the report at the 
end of a test. This file must be in .jpg format.

8. When finished, click “OK”.
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Software
Calibration - 
Consistency

A calibration should be performed periodically to make sure the unit is 
still providing accurate information. Also, be sure to calibrate any time the 
potentiometer is changed. Always calibrate with the same potentiometer 
that will be used during the test.

1. Select Utilities → Calibrate → Consistency.

2. Prepare the potentiometer for calibration as described on page 35.

3. Set the “15 VDC” switch to AUTO.

4. Place the weight hanger (with no weights) on the end of the string. The 
weight hanger is 50 g.

5. Wait for the value on the screen to stabilize and then click “Accept”.

6. The software will prompt you to add weight to the hanger. After adding the 
weight, wait for the value to stabilize, then click “Accept”.

At any time you can click the “Back” button to re-enter a calibration point.

7. At the end of the sequence, the software will show you the Slope, r2 
Value, and the y-intercept.

8. Click “Save” to save the calibration data.
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The temperature should not need to be calibrated unless the thermocouple is 
replaced or the software on the PC is reinstalled.

1. Select Utilities → Calibrate → Thermocouple. 

2. Insert the thermocouple into a dry block calibrator and set the “PUMP” 
switch to OFF.

3. Click “Accept”.

4. Follow the onscreen instructions. Set the dry block to the first setpoint. 
When the Measured value stabilizes, click “Accept”.

5. Repeat step 4 for all setpoints in the sequence.

6. At the end of the sequence, the software will show you the Slope, r2 
Value, and the y-intercept.

7. Click “Save” to save the calibration data.

Software
Calibration - 

Thermocouple
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1. Connect a calibrated gauge to the thermocouple port in the cell cap. 

2. Close the Pressure Release valve.

3. Follow the onscreen instructions. When the Measured value stabilizes, 
enter the value from the calibrated gauge into the field and click “Accept”.

4. Repeat step 3 for each setpoint in the sequence.

5. At the end of the sequence, the software will show you the Slope, r2 
Value, and the y-intercept.

6. Click “Save” to save the calibration data.

Software
Calibration - Pressure 

Transducer
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Software
Operation

1. If you have not already built a test, refer to page 13 for instructions.

2. Select “Test” from the “Edit” menu.

3. On the Information tab, enter the necessary information. The following 
fields do not affect your test. This information will print on the report when 
the test is complete:

• Test Name
• Test ID
• Rig Name
• Customer
• Well Name
• Lab Technician
• Pad Name
• Cement Manufacturer
• Cement Class
• Cement Density
• Job Type
• Bottom Hole Circulating Temperature (BHCT) 
• Bottom Hole Staic Temperature (BHST)
• Blend
• Additives
• Comments

4. On the “Configuration” tab, set the following options:

• Stop at End: When this option is “No”, the test will run until you click 
the “Stop Test” button. The final temperature setpoint and motor 
setting will be maintained indefinitely. If this option is “Yes”, the test 
will end when all steps in the Test Profile are complete.

• DAQ Rate: Determines how often test data is saved to file
• Temp Unit: choose F or C
• Press Unit: choose psi or MPa

5. On the “Profile” tab, choose a test profile from the list. To create a 
new profile, click the “Open Builder” button. See page 13 for more 
information.

6. Click “Save” to save the test settings.

7. To start a test, click the “Start Test” button in the bottom left-hand corner 
of the screen.
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Software 
Test Builder

The Consistometer Software can control the temperature and motor during a 
test. Tests are programmed in the Test Builder.

1. Select “Test” from the “Edit” menu. On the “Profile” tab, click “Open 
Builder”.

2. Click the “New Test” button to start a new test. Or click the “Copy Test” 
button to start with an existing test.

3. On the Temperature tab click the “Add” button to add a step.

4. Choose a Step Type:

 - Ramp: The software will increase the setpoint up to the target over 
a specified time period. You will be asked for a time period (minutes) 
and a target temperature.

 - Step: The software will increase the setpoint to the target immediately. 
You will be asked for a target temperature.

 - Hold: Maintain the current setpoint for the specified period of time. 
You will be asked for a time period (minutes).

5. On the Motor tab, click the “Add” button to add a step.

 - You can choose either “Motor On” or “Motor Off”. You will be asked for 
a time period (hh:mm:ss).

6. Once you add a step, you can then go back and edit, delete, or move it 
up or down in the step list.

7. Click “OK” to save the test. The new test will now be available on the “Edit 
Test” screen.
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Software
Test Data

At the end of each test, all test data is saved in the “Data Archive Folder” that 
was selected in the “Setup” screen. There you can find an image showing the 
chart for each test as well as a data file that can be opened in MS Excel.

Archived tests and calibrations can also be viewed in the software:

1. Select “Test Archive” or “Calibration Archive” from the “File” menu.

2. On the left-hand side of the screen, choose a test or calibration to view. 
The graph will be displayed in the chart area.

3. To print the chart, click the “Print to File” button.

You can also print a chart or export test data during a test. Simply right-
click on the table at the bottom of the main screen. From the context 
menu, select either “Print Chart” or “Export”.

a. “Print Chart” - This will print the current chart. 

b. “Export” - This will export the current test data to a file in the archive 
folder.
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Software
Events

Events are triggered based on conditions in the test. When an Event is trig-
gered, it can send an alert, end the test, or both.

To manage Events, choose Test from the Edit menu. Then go to the Configu-
ration tab and then the Events tab. 

1. Choose a Signal: Time, Temperature, Pressure, BC.

2. Enter the Value you want to test for. For example, if your Signal is Tem-
perature, then a Value of 100 represents 100°.

3. Enter the time (in seconds) you want the Signal to be at the specified 
Value before triggering the event. 

4. Choose a Condition.

5. If you want to be alerted when the conditions are met, select Enable un-
der Alert.

6. If you want the test to end when the conditions are met, select Enable 
under End Test.

7. Click the Add button to add the Event.

8. To modify an Alert, select it in the list, make your changes, and then click 
the Update button.

9. Click Save.
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Calculated Values are triggered by conditions in the test. They are printed on 
the chart at the end of the test.

To manage Calculated Values, choose Test from the Edit menu. Then go to 
the Configuration tab and then the Calculated Values tab. 

1. Choose a Signal: Time, Temperature, Pressure, BC.

2. Choose a Calculation:

• At Time: Calculate the value of the Signal at a specific test time
• Time When: Calculate the time when the Signal reaches a specified 

value
• Signal Min: Calculate the minimum Signal value for the test
• Signal Max: Calculate the maximum Signal value for the test
• Transition Time: Calculate the time it takes the Signal to change from 

one value to another

3. Fill in the remaining fields. These fields will change depending on which 
Calculation you choose.

4. Click the Add button to add the Calculated Value.

5. To modify a Calculated Value, select it in the list, make your changes, and 
then click the Update button.

6. Click Save.

Software
Calculated Values
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The Benchtop Consistometer features an onboard display. It provides access 
to basic test configuration and control and makes it possible to run the instru-
ment without an external computer. The display can be operated either as a 
touch screen or with the control wheel. 

To operate the display with the Control Wheel:

1. Turn the Control Wheel to scroll through the available parameters.

2. Press the Control Wheel to select a parameter.

3. Turn the Control Wheel to scroll through available values for the param-
eter.

4. Press the Control Wheel to select a value.

Onboard 
Display
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The Real-Time Data screen is the default screen. When the display has been 
idle for more than 2 minutes, it will automatically revert to this screen. Here 
you can see the current test parameters. This screen does not accept any 
inputs.

Onboard 
Display

Real-Time Data

Real-Time Data
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Onboard 
Display

Test Setup - Profile

On the Profile tab of the Test Setup screen, you can create a Test Profile for 
your test.

1. Choose a Parameter (Temperature or Motor).

2. Choose a Step Type:

Temperature

Ramp: This will increase the temperature up to the target in a set number 
of minutes. Enter the ramp time and target.

Step: This will increase the temperature up to the target as fast as pos-
sible. Enter the target temperature.

Dwell: This will hold the current temperature for a set number of minutes. 
Enter the time.

Motor: On or Off

3. Enter the parameters for the step (ramp time, target temperature, motor 
on/off, etc).

4. Select the “ADD STEP” button.

5. To remove a step, select it in the list and select the “REMOVE STEP” but-
ton.

6. When you are finished adding steps, select the “SAVE” button.
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On the Calibrate screen, the onboard display can calibrate the pressure 
transducer, thermocouple, and potentiometer. 

1. Select the system (Pressure, Temperature, Consistency) to calibrate.

2. Follow the onscreen instructions.

Pressure: Attach a calibrated pressure gauge to the thermocouple port in 
the cell cap.

Temperature: Plug the thermocouple into the Thermocouple Port on the 
top of the Main Unit. Place the thermocouple into a dry block calibrator.

Consistency: See page 35.

Onboard 
Display

Calibrate
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The Utilities screen sets general parameters.

1. Enter the values for each parameter:

Temperature: Choose either °F (Fahrenheit) or °C (Celsius)

Pressure: Choose units for cell pressure (psi or MPa).

2. Select “Apply” when done.

Onboard 
Display

Utilities
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On the Archive screen, saved calibrations and tests can be exported to a 
USB drive.

1. Place a USB drive in the Data Export port on the Control Box.

The port has an indicator light to show the status of the inserted drive:

a. Green: The drive is inserted and supported.

b. Amber: The drive is inserted and supported, but low on free space.

c. Red: The drive is inserted but not supported. Make sure the drive is 
formated in the FAT32 file system. 

2. On the left-hand side of the screen, choose either Tests or Calibrations. 
The list of available tests or calibrations will populate on the right.

3. Choose the item to export.

4. Select “Export”. The file will be saved to the USB drive.

Onboard 
Display

Archive
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The Manual Control screen can be used to set the temperature when a test is 
not running. The Heat switch must be set to AUTO.

1. Enter the setpoint in the box.

2. Select “SET” when done.

When setting the temperature with Manual Control, a thermocouple must 
be connected to the port on the bulkhead to prevent alarms. 

Onboard 
Display

Manual Control
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The Start Test button starts a test using the parameters that are currently 
saved to the internal board. Before pressing the Start Test button, be sure to 
configure your test parameters on the Test Setup screen (see page 19) or 
in the PC software (see page 13).

Also note, when saving settings in the onboard display, the settings displayed 
on the screen will be saved to the board, but other settings that were previ-
ously set in the software will be replaced by defaults.

Onboard 
Display

Start Test
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The Graphs screen shows a graph of the current test with lines for Tempera-
ture, Pressure, and Consistency with respect to Time.Onboard 

Display
Graphs
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Operation
Filling the Slurry Cup

1. With the slurry cup disassembled, examine the threads on the inside of 
the cylinder. The end with the larger set of threads is the top.

2. Coat the surface of the paddle and the inside of the slurry cup with a high-
temperature grease to facilitate cement removal.

3. Insert the paddle assembly all the way into 
the top of the cylinder.

Cylinder

Paddle

Bottom Cell Cap Locking Ring

Gasket

4. Slide the slurry cup lock ring on top of the paddle assembly with the two 
notches facing upward. Tighten the locking ring completely using the 
provided slurry cup tool.

5. Prepare the cement slurry as stated in API Specification 10.

6. Pour the cement into the slurry cup through the open bottom of the 
cylinder.

7. Place the gasket around the threads of the bottom cap. Apply high-
temperature grease to the gasket and cap surface. Screw the cap onto 
the cup and tighten with the slurry cup tool.
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The slurry cup should contain enough cement slurry that it leaks out of the 
hole in the center of the cap. If it does not, remove the cap and refill the 
slurry cup. Do not add cement through the hole in the cap.

8. Screw the pivot bearing into the hole in the center of the cap and tighten.

9. Wipe the entire slurry cup clean to ensure that no cement remains on the 
outside.

Pivot Bearing

Slurry Cup Tool
Slurry Cup

Slurry Cup Stand
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Operation 
Loading the Test Cell

Before attempting to load the test cell, ensure that the “Air To Cylinder” and 
“Pressure Release” valves are completely closed (turned clockwise). Also, 
make sure the “Motor”, “Pump”, and “Heat” switches are turned off.

1. Lower the slurry cup into the test cell ensuring that the slurry cup drive 
pins engage the drive holes at the bottom of the test cell.

It may be necessary to start the motor briefly to confirm that the slurry cup 
is properly aligned inside the test cell.

2. Lower the potentiometer mechanism into the test cell ensuring that the 
contact springs of the potentiometer are in alignment with the test cell 
contacts.

The slurry cup and potentiometer both have two holes near the top for 
the lift bail (provided). Use the lift bail to easily lower the slurry cup and 
potentiometer into the test cell.

Lift Bail

Drive Holes

Potentiometer 
Contacts

Test Cell
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3. To engage the drive bar of the slurry cup into the potentiometer, rotate the 
cup with the motor for a few seconds while applying slight pressure to the 
potentiometer. Note that if the unit is in an alarm condition the motor will 
not engage.

4. Place the metal seal ring, the o-ring, and the retaining ring onto the cell 
cap as shown below. Place the cell cap onto the cell and hand tighten.

Thermocouple

Cell Cap

Thread Gland

5. Plug the thermocouple into the port on the unit cabinet. Insert the 
thermocouple into the hole in the top of the cell cap and tighten the thread 
gland finger tight. Then loosen it ⅛ of a turn.

6. With a ⅝" wrench handy, turn the “Oil Reservoir Valve” to “Fill Cell”. The 
test cell will begin to fill with mineral oil from the reservoir. Carefully watch 
the top of the test cell. When oil begins leaking out of the thermocouple 
hole, tighten the thread gland with the wrench. This will ensure that no air 
remains within the test cell.

Retaining Ring 
(#120-148)

Metal Seal 
(#120-90-049)

O-ring, Viton 
(#120-149)
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7. Turn on the “Motor” and “15 VDC” switches.

The “15 VDC” switch MUST be on in order to read the cell pressure 
on the display or in the software. Leave the “15 VDC” switch on any 
time there is pressure on the test cell.

8. Turn on the pump. Adjust the pressure to the desired level by turning the 
regulator clockwise.

If the pressure rises too high, open (counterclockwise) the “Pressure 
Release” valve very slowly. Close the valve immediately to prevent all of 
the pressure from leaking.

9. Turn the “Heat” switch on. If you are using the Benchtop Consistometer 
software, click the “Start Test” button (refer to page 12 for more 
information). If you are not using the software, touch the “Start Test” 
button on the display.

10. If the “Alarm” switch is not already on, turn it on now. If the “Alarm” switch 
is left off, the unit can still enter into an alarm condition, but there will be 
no visual or audio signal to notify the operator
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Operation 
Completing the Test

1. If you are using the Benchtop Consistometer software, click “Stop Test”. If 
not, touch the “Stop Test” button on the display.

2. Turn off the “Heat” and “Pump” switches and turn on the “Cool” switch. 
Make sure the water supply is turned on.

3. As the test cell cools, watch the pressure carefully. As long as the 
temperature is over 180°F (82.2°C), make sure the pressure is at least 
1,000 PSI (6,900 kPa).

4. Once the test cell has cooled, turn off the“Cool” and “Motor” switches.

5. Open the Pressure Release valve (counterclockwise) all the way.

Always release the pressure very slowly to avoid pulling cement into 
the plumbing.

6. Once the cell pressure reaches 0, turn the “15 VDC” switch off.

7. Slowly turn the “Oil Reservoir Valve” to “Vent”.

8. Open the “Air To Cylinder” valve (counterclockwise). Air pressure will 
force the oil back into the reservoir. You will hear a hissing sound as air is 
released. When the hissing sound stops, close the valve (clockwise).

9. Carefully unscrew and remove the thermocouple.

Keep a rag or paper towel handy in case extra oil leaks from the cell.

10. Unscrew and remove the cell cap. Remove the potentiometer and slurry 
cup.

11. Return the cell cap to the test cell to prevent dust and other material from 
entering the cell. Close all valves and turn off all switches.
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Maintenance Slurry Cup

After every test, immediately disassemble the slurry cup and clean it 
thoroughly with soap and water. Be sure to remove any residual cement 
before it hardens. Hardened cement on any of the parts can cause 
irreparable damage.

Test Cell

After every test, examine the inside of the test cell for any cement or other 
debris. If necessary, wipe the inside of the cell with a rag or paper towel.

Oil Filter

If oil is not flowing from the oil reservoir to the pump, it may be necessary 
to replace the oil filter.

1. Open the back panel of the main unit cabinet and locate the oil filter 
fixture.

2. Open the fixture, remove the filter, and replace it with a new one.

To reduce the risk of damaging the piping around the fixture, you can 
completely remove the entire fixture from the unit. Once you have 
replaced the filter, be sure to re-install the fixture with the oil flow 
directed downward. An arrow printed on the side of the fixture shows 
the direction of the oil flow.

Oil Filter Fixture Fixture Filter
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Maintenance 
Potentiometer 

1. The potentiometer should be kept as clean as possible. Periodically 
submerge the unit in solvent to remove cement and other materials.

2. Troubleshooting potential problems:

a. If consistency (voltage) readings fluctuate, examine the resistor and 
verify that the top is smooth and consistent. If necessary, re-insert the 
resistor and lightly smooth the resistor wire with emery cloth.

b. If the consistency (voltage) reading is zero, the resistor and contact 
arm may have lost contact. Adjust the contact arm either up or down. 
If this does not correct the problem, the resistor may have insufficient 
space between the windings to prohibit conductance. If this is the 
case, replace the resistor.

c. If the potentiometer will not hold a calibration, the spring is probably 
either damaged or worn by corrosion. Replace the spring.

3. To install a new resistor:

a. Remove the four small screws holding the shaft-bearing retainer to 
the potentiometer assembly.

b. Remove the contact arm.

c. Carefully lift the damaged resistor away from the potentiometer. Clear 
the resistor groove of any foreign material.

d. Carefully place the new resistor into the groove and ensure that it is 
centered between the two terminating contacts.

e. Push the resistor completely into the groove with either a mallet or 
a piece of wood. It is very important to ensure that the resistor is 
completely inserted into the groove and that the upper surface is level.

f. Install a new contact arm and if necessary, bend the arm either up or 
down to obtain consistent contact with the resistor.

g. Re-install the shaft-bearing retainer and calibrate the potentiometer 
before use.

4. To install a new calibration spring:

a. Remove the contact arm and the shaft-bearing retainer.

b. Carefully lift the calibration spring from the potentiometer assembly.

c. Install the new spring. When properly installed, it should tighten when 
the center shaft is rotated counter-clockwise.
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d. Install a new contact arm and make adjustments as necessary to 
obtain consistent contact with the resistor.

e. Loosen the three adjustment screws on the underside of the 
potentiometer assembly and rotate the spring adjuster until the spring 
rests at a relaxed state.

f. Ensure that the contact arm aligns with the contact strip and tighten 
the three set screws.

g. Rotate the center shaft to ensure that the spring does not bind or rub 
the potentiometer housing.

h. Replace the shaft-bearing retainer and calibrate the potentiometer.

Shaft-Bearing
RetainerContact Arm

Resistor

Calibration Spring

Set Screws
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Appendix
Potentiometer Calibration

The potentiometer should be calibrated once a month to ensure accurate 
readings. If you are using the CEM-D software or the onboard display, use 
the built-in calibration procedure. Otherwise, follow these steps:

1. Place the potentiometer on the calibration stand. Place the stand on the 
edge of the Consistometer and plug it into the port on the top of the unit.

2. Connect the wire clamps to the contacts. From the groove going 
clockwise around the unit, connect yellow, then black, then blue.

3. Slide the weight into the groove and wrap the cord clockwise around the 
unit one full turn.

4. Let the cord hang over the wheel and off the table.

5. Attach the hook to the cord.

6. Apply the weights to the hook according to the chart below. Steady the 
cord to minimize the amount of swinging.

When adding weights, remember that the hook weighs 50 grams. 
Therefore, to test the potentiometer at 200g, you only need to add 150g 
to the hook.

7. Firmly tap the surface of the calibration stand with a pen or the blunt end 
of a screwdriver to settle the weights and stabilize the potentiometer.

Calibration 
Stand
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8. Lift the weight about two inches directly upward and release it. Allow it to 
fall straight down. Observe the reading on the Potentiometer Indicator.

9. Record the reading and repeat steps 6 through 8 with each weight listed 
in the chart below.

The voltage values in this chart are only examples. Every potentiometer 
is different and will, therefore produce different voltages. The calibration 
process will help you interpret the potentiometer readings provided by the 
Consistometer.  

Mass (grams) Approximate Voltage

100 2.5

200 5.5

300 8.2

400 10.75
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Appendix
Potentiometer Adjustment

The calibration spring has a zero point. If the contact arm is behind the zero 
point, the potentiometer will register a negative reading. If the contact arm 
drifts behind the zero point, it will be necessary to adjust the position of the 
spring.

1. Remove the potentiometer from the consistometer.

2. Loosen the three set screws on the bottom of the potentiometer.

3. Locate the spring holder on the top of the potentiometer. It may be 
positioned beneath the shaft bearing retainer. Push the spring holder to 
rotate the spring within the body of the potentiometer.

4. When the contact arm is again in front of the zero point, tighten the set 
screws to secure it in place.

5. The contact arm may drift while tightening the set screws. Recheck the 
position of the contact arm before using the potentiometer.

Negative Reading Positive Reading

Zero Point Zero Point

Spring Holder

Shaft Bearing 
Retainer
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Appendix
Diagrams

#120-519 Slurry Cup Assembly

Shear Pin (#120-511)

Drive Disk (#120-509)

Diaphragm Support
(#120-515)

Locking Ring (#120-517)

Diaphragm Retaining Ring 
(#120-508)

Paddle Pin (#120-503)

Sleeve (#120-501)

Base (#120-516)

Drive Pin (#120-512)

Pivot Bearing (#120-504)

Drive Bar (#120-510)
Drive Disk Set Screw 
(#120-514)

Paddle Shaft (#120-507)

Molded Diaphragm
#120-502 - Below 400°F
#120-40-502 - Above 400°F

Paddle (#120-506)

Gasket (#120-513)

Pivot Bearing Gasket 
(#120-505)
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#120-90-00 Cell Assembly

Handle, Qty: 2 
(#120-90-047)

Top Cap

Metal Seal 
(#120-90-049)
Retaining Ring 
(#120-148)

Heater Coil 
(#120-206)

Cooling Jacket 
O-ring, Qty: 2  
(#503-258V90)

Table Drive 
(#120-90-044)

Cell Body

Legs, Qty: 3 
(#120-55-034)

Spacer, Qty: 2 
(#120-206B)

Hex Hex, 10-32 
× .125, Qty: 2 
(#120-206D)

Washer, Qty: 2 
(#120-206C)

Mag Drive 
Assembly

O-ring 
(#120-149)

Heater Shield 
(#120-35-057)

Heater Gasket, Qty: 2 
(#120-204)

Cooling Jacket

Drain Plug

O-ring 
(#120-257)

Contact Pin 
Assembly 

(#120-90-097)

7/16-20 × 9/16 L, Hex 
Jam Nut, Qty: 2 
(#120-206A)
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Warranty and 
Return Policy

Warranty:
OFI Testing Equipment, Inc. (OFITE) warrants that the products shall be free from liens and defects in 
title, and shall conform in all respects to the terms of the sales order and the specifications applicable 
to the products. All products shall be furnished subject to OFITE’s standard manufacturing variations 
and practices. Unless the warranty period is otherwise extended in writing, the following warranty shall 
apply: if, at any time prior to twelve (12) months from the date of invoice, the products, or any part 
thereof, do not conform to these warranties or to the specifications applicable thereto, and OFITE is 
so notified in writing upon discovery, OFITE shall promptly repair or replace the defective products. 
Notwithstanding the foregoing, OFITE’s warranty obligations shall not extend to any use by the buyer 
of the products in conditions more severe than OFITE’s recommendations, nor to any defects which 
were visually observable by the buyer but which are not promptly brought to OFITE’s attention.
In the event that the buyer has purchased installation and commissioning services on 
applicable products, the above warranty shall extend for an additional period of twelve 
(12) months from the date of the original warranty expiration for such products.
In the event that OFITE is requested to provide customized research and development for the buyer, 
OFITE shall use its best efforts but makes no guarantees to the buyer that any products will be provided.
OFITE makes no other warranties or guarantees to the buyer, either express or implied, 
and the warranties provided in this clause shall be exclusive of any other warranties 
including ANY IMPLIED OR STATUTORY WARRANTIES OF FITNESS FOR PURP

OSE, MERCHANTABILITY, AND OTHER STATUTORY REMEDIES WHICH ARE WAIVED.
This limited warranty does not cover any losses or damages that occur as a result of:

Improper installation or maintenance of the products

Misuse

Neglect

Adjustment by non-authorized sources

Improper environment

Excessive or inadequate heating or air conditioning or electrical 
power failures, surges, or other irregularities

Equipment, products, or material not manufactured by OFITE

Firmware or hardware that have been modified or altered by a third party

Consumable parts (bearings, accessories, etc.)

Returns and Repairs:
Items being returned must be carefully packaged to prevent damage in 
shipment and insured against possible damage or loss. OFITE will not be 
responsible for equipment damaged due to insufficient packaging. 

Any non-defective items returned to OFITE within ninety (90) days of invoice are subject to a 
15% restocking fee. Items returned must be received by OFITE in original condition for it to 
be accepted. Reagents and special order items will not be accepted for return or refund.

OFITE employs experienced personnel to service and repair equipment manufactured by us, as 
well as other companies. To help expedite the repair process, please include a repair form with all 
equipment sent to OFITE for repair. Be sure to include your name, company name, phone number, 
email address, detailed description of work to be done, purchase order number, and a shipping address 
for returning the equipment. All repairs performed as “repair as needed” are subject to the ninety (90) 
day limited warranty. All “Certified Repairs” are subject to the twelve (12) month limited warranty.

Returns and potential warranty repairs require a Return Material Authorization (RMA) 
number. An RMA form is available from your sales or service representative.

Please ship all equipment (with the RMA number for returns or warranty repairs) to the following address:

OFI Testing Equipment, Inc.  
Attn: Repair Department  
11302 Steeplecrest Dr.  
Houston, TX 77065 
USA 

OFITE also offers competitive service contracts for repairing and/or maintaining your lab 
equipment, including equipment from other manufacturers. For more information about 
our technical support and repair services, please contact techservice@ofite.com.
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